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Spreadsheets

Spreadsheets are used to store, organise and analyse data. You can create contact lists,
inventories, budgets, invoices, and much more.

In this course, we used Microsoft Office Excel as a program that can be used to create
spreadsheets.

To open Excel, go to the list of programs on your computer, select Microsoft Office, and
then select Microsoft Excel.
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Or on your desktop, double click the icon

Or on the task bar single click the icon

With Windows 7 or higher, you can type Excel in the search bar and the option of the Excel
& Mo Beced 2070

program will appear at the top of the results. I .._. Click on it to open
the program.
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Excel Basics
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When Excel opens, you seea grid. This is a spreadsheet. There are tabs at the bottom on
the Worksheet Bar where you can name your worksheet and add additional sheets. Some
versions of Excel open with three worksheets. You can add more worksheets, and you don’t
have to use all three. You can name the worksheets. For example, you could have twelve

worksheets in a workbook, one for each month.

When you use Word, the file created is called a document. In Excel, the file you create is
called a workbook. (Before you save a file, it may say Book 1 or Unsaved Spreadsheet on
the Title Bar.) When you open Excel, a new workbook will open. (You can open another
new workbook by clicking on blank document icon on the Quick Access Tool Bar just as
you do to open a new document in Word.)
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Creating a worksheet

The worksheet that you see when you open the workbook is a grid made of thousands of
rectangles. Each rectangle is called a cell. The cell is the intersection of a column and a
a1 B £ row. Each column has a letter at the top. The rows
A '8 ¢ p  haveanumbersattheleft. A cellis identified by the

e==id combination of the alphabetic reference at the top and
the number on the row. This is called the cell
reference or name.
In this picture the cell with the dark line around it is
named Al.
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The cell Al is outlined when you open a new workbook. This is the active cell. The active
cell has the dark line around it and a small square on the lower right had corner. The active
cell is where the next thing you type will be entered.

The Name Box on the left hand side of the Formula Bar shows the reference of the active
cell. The heading of the column and the heading of the row will be highlighted as well. As
well as clicking in a cell to move to it, you can type the cell reference in the Name Box and
press ENTER. You can also move to a cell by pressing F5 on the keyboard which will open
the Go To dialog box. Type in the reference for the cell you want and press ENTER. These
last two methods are useful if the cell you want is not visible on the screen.

The Worksheet can have 1,048,576 rows and 16,384 columns in Excel 2007 or above. You
will most likely never use all of this, but if you need them...

The scroll bars on the right and bottom of the window can be used to move around the
worksheet to parts that are not visible. However, in a new worksheet, the scroll bars only a
few additional rows or columns. Once you have entered data (even a space), the scroll bars
will allow you to move to any cell which contains data.
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Working with cells

To select a cell, click in the cell. You will see the cell outlined, the name box display the
cell reference, and the column and row headings will be highlighted. You can also select a
cell by using the arrows on your keyboard.

Entering data
A cell is where you enter the data. Cells can hold text, numbers and formulas, formatting,
and functions.

To enter data, click on the cell to select it, and then type your data. Your entry will appear
in the cell, and also in the Formula Bar. As you enter the data, you can use the backspace
= key to delete the last character typed.

-..‘AA‘ = = »-;—« &—-Dfﬁu?fy =2 To enter the data,
L [ ! l click on the Enter/Return key on your
2 keyboard to move down to the cell below the
3 entry.
Or click the Tab key to move to the cell to
the right of the entry.

To delete data, select the cell with the data you want to delete and press the delete key on the
keyboard, or the backspace key on the keyboard. If you only want to delete part of the entry,
g0 to the data on the formula bar and backspace one character at a time, or edit it as you
wish.

Other ways to enter data

As above, you can go to a cell and type in the data that you want. Some quick ways to enter
certain types of data are as follows:

The fill handle

To fill adjacent cells with the same data, hover the mouse over the lower right hand corner of
the cell with the data until you see the fill handle. —E . Then click and drag the mouse
over the range of cells to fill. Release the mouse, and the data will fill the selected cells.
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To continue a series with the fill handle, highlight the cells with the series so far, select the
fill handle on the last of the series, and then click and drag to the cells to be filled.
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You will be able to see the suggested fills as you drag the mouse. Release the mouse to fill
in the selected cells.

Auto Complete

[f the first few letters you type in a cell match an entry you've already made in that column,
Excel will fill in the remaining characters for you. Just press ENTER when you see them
added. This works for text or for text with numbers. It does not work for numbers only, for
dates, or for times.

Hints about entering data
CTRL and Home will take you back to cell Al.
Dates must be entered with hyphens or slashes (or virgules), NOT full stops.

Times must be entered with a space and then a or p, or they will be interpreted as am. When
entering times for midnight use 0:00.

To enter today's date, press CTRL and the semicolon together. To enter the current time, press
CTRL and SHIFT and the semicolon all at once.

Some hints about entering numbers.

Fractions without a whole number will be interpreted as dates

To enter fractions, leave a space between the whole number and the fraction. For example,
11/8.

To enter a fraction only, enter a zero first. For example, 0 1/4. If you enter 1/4 without the
zero, Excel will interpret the number as a date, January 4.

Numbers in parentheses show as negative. Type (100) to indicate a negative number by
parentheses and the result is displayed as -100.

Fractions show as decimals in the formula bar.
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Workbooks and worksheets

Save the workbook — Click on File on the menu bar. Click on Save. The rest is the same
as saving a word document. Notice that the Excel workbooks will have a file extension of
-xls (2003 or earlier) or .xlsx. Spreadsheets in Microsoft Works will have an extension of
Xlr.

Rename a worksheet - right click on the worksheet tab and select rename from the menu.
Then type the name you require.

Add colour to worksheet tabs - right click on the worksheet tab and selecting
Tab color. Click on the colour of your choice. The active sheet will be underlined in the
colour. Inactive sheets will be filled with the colour.

Move from one worksheet to another by holding down the Ctrl key and Page Down to
move to the right, Ctrl and Page Up to move to the left.

Add a worksheet - Right Click one of the worksheets. Hold down the shift key and press
F11. The new worksheet will be inserted before the active worksheet. To add a worksheet
after the last worksheet, clickon ~  on the Worksheet Bar.

a4 + 4 ¢ s« — Movea worksheet - Click on the worksheet
[l - | you want to move on the worksheet bar and
I drag it to where you want the sheet to go.

Delete a worksheet — Click on the sheet you want to delete. Click on Edit on the menu bar.
Click on Delete sheet. If you have any data in the worksheet, you will see a box that asks if
you are sure that you want to delete the sheet.

If you want to go ahead, click on Delete.

Selecting areas of a spreadsheet

To select a range of cells, click and drag the mouse over the range of cells. They area will
appear highlighted, and the active cell will not be highlighted.

B

To select multiple ranges of cells, hold down the control key on the keyboard, click and
drag with the mouse over the first range, then still holding down the control key, click and
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drag with the mouse over the next range, and so on. When all the ranges are selected, release
the control key.

To select a column, click the mouse pointer onto the column letter at the top of the column.
The entire column will be highlighted, down to row 1,048,576.

To select a row, click the mouse pointer onto the row number on the left of the screen. The
entire row will be highlighted up to column 16,384,

To select the entire worksheet, click the mouse pointer on to the blank box to the left of the
column letters and the top of the row numbers. The entire worksheet will be highlighted.

Columns and Rows

To insert a column between ones already containing data, select the column that will be to
the right of the one you want to add. Right click on the mouse and click on insert from the
menu.

To insert more than one column, select the column that will be to the right of the added
columns. Click and drag the mouse over the number of columns to the right of the selected
column that you wish to add. Rjght click on the mouse and click on insert from the menu.
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To insert a row between ones already containing data, select the row that will underneath
the one you want to add. Right click on the mouse and click on insert from the menu.
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To insert more than one row, select the row that will be underneath the added rows. Click
and drag the mouse over the number of rows below the selected column that you wish to
add. Right click on the mouse and click on insert from the menu.
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To delete columns or rows, select the columns or rows you want to delete.
Right click on the mouse and click on Delete, or click on the Delete commandon the
ribbon. Deleta
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To change the width of a column

Put the mouse on the line between the letters at the top of the column you want to change
and the column to its right until it becomes a double arrow. Click and drag the mouse to the
right or left to make the column wider or narrower. If you want to change several columns to
be the same width, select them all, click and drag any one of them, and the change will apply
to them all.
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If you put the mouse on the line between the letters at the top of the column you want to
change until it becomes a double arrow and double click, it will make the column to the left
as wide as the cell with the widest data in the column. This is called ‘best fit’.

Y LJ L . » - .

white white

black black

crimson crimson

aguamarine aguamarine
Before After

To change the height of a row, put the mouse on the line below the row you want to change
between the row numbers until you see the double arrow. Click and drag the mouse, as with
the columns, until you achieve the desired height.

The Cells group on the Home ribbon in Excel 2007 and above will also allow you to do
these functions. It is for you to decide which is better for you.
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Alignment of text in the cells

You can decide how you want the text within the cell to be aligned. By default, text will be
aligned to the left, and numbers to the right.

You can use the icons in the Alignment group of the Home ribbon to change the alignment to
fit your spreadsheet. Hover over each icon to see how it will align the text within the cell.
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Merge & Center in the group is useful when you want to add titles to the worksheet or
groups of columns. For example: When I highlight the entire row above my data,
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en click on Merge & Center, the title straddles the width of my data and the text is
centred. I can further enhance the title, if I wish.
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This can be used within the spmdsheetaswell
A 8 C D £ = c
Utilities
Gas Electric Water
British Gas Britls Gas East Surrey
Jjan £40 Jan £35 2014 £200

2N Y BN
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Number Formats

Just as you can format text, in Excel you can choose to format numbers in a specific way.
There are two ways you can format numbers.
1. Input the numbers, and then format them.

Select the numbers you have entered TR

PR T N S

On the Home tab ribbon, under the
number group, click on one of the
options, or on the down arrow to see
more.

For example, clicking on the currency A
down arrow, and then on £, the result is
like this.

Clicking on Percentage would have a
different outcome

You can change the number of decimal
places displayed by click on the Increase

i
or Decrease decimal icons

O W B W e
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Selecting date would have given a
different outcome.

o W e

Select the cells where the numbers will be enterecgand then add the data.

Select the cells, row, or column to be
formatted.

Right click on the selected area, and T
select Format cells. In this example, o
click on Date, and choose the format e o
for your date. Click on OK. = B
.-r":'::‘*”;.'.‘::::&:-i'-;n';g'
When you enter the date as 1/3/2017, it . ‘
will appear in the cell in your selected & 01/03/2017
format. c D £
In this example, click on currency. o S
Choose the format you want to use g s
R =
When you enter data, it will assume 22 > o
that you are entering currency and Py . z =
display it in the format you have S350
selected.
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Working with calculations

In Excel, mathematic calculations can be done by using keys on the keyboard for the
operation that you want to do.

To Add, use the + sign (shift and =)

To Subtract, use the — sign (the key next to =, also used for a hyphen)
To Multiply, use the * (star, shift and 8)

To Divide, use the / (forward slash, next to the right hand shift key)

To show exponents, use the * (caret, shift and 6)

All calculations start with =,

You can do calculations within a cell using X  f =242

these principles c 5 5 <
820

When you press Enter or tab to move to fe =242

another cell, the result of the calculation c 5 c

appears in the cell, but the IZ

Generally in spreadsheets, however, the data is entered into each cell, and the results ina
separate cell. The cell references are used in the calculations.

X v & =£1:82 L =Ei1+€2
C > >

m
n
()

ra

m
[ NI ]

sEl+£2

which becomes

That way, if I change a figure in either E1 or E2, the calculation will reflect the change.
fo =E1:E2
D

E5
2
—
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You can use this method for cells that are not next to each other as well.

sum v wv L o= 8 - fo *86.56

A 5 ¢ b) £ F - 8 c ) :
i income. imes Food Specging . ingome UYiives  Food Speroing
2 Weekl £120.00 4248 £ 2248 D weekl £120.60 4265 € 4283
I Weekl 100 I RS € 4820 £3045 3} Wesk2 £1M000 £ 3225 € 20 £13048
4 Weak3  g00c £ 3567 € 3567 & Week3 £12060 € 3847 £ B8E
S Weaks £12000 € 8472 £ 4882 £1318 S Weeké €100 E SAT2 € 6542 £1221a
6  Easoce LE3c9 s €480.08 £330.9¢
: :

This becomes even more useful with many cells of data. So in Excel there is a way to make
calculations easier. AutoSum is one of them. The AutoSum button is on the home ribbon.

It looks like this: * . The drop down arrow next to it lets you choose the calculation you

want.
‘111 You can add the AutoSum function for addition to your Quick Access Toolbar if you

use it often.

To use it, click in the cell at the bottom of a column of numbers. Then click on the
AutoSum button, A border will go around the all the cells that will be used to create the

total. When you press Enter, the total will appear in the cell.

£ Bock? « Mhereceh Bacel mon~conwrercal vt - o x

RV L aSOVtLES) -
[ o} £ : e - P . o N o R
4
13}
3.
> 4
. 7}
AN
Y00 mavmber! N l
o =SUMELES) Notice that the formula bar shows the calculation as
= 0 L ¢ =SUM(E1:E6). You could type in this formula yourself,
o but it is easier to use the AutoSum function.
3]
%0
22
73
1036
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You can combine cell references with numbers to do calculations. Here are some examples.

Ci v A =A12 CL - L =Al1*S
A B C D £ A & ¢ ° E
1 52 1 37
Divides the number in Al by 2 ~ Multiplies the number in Al by 5
€1 v fe  =A1%15% : 1 v B =A1R2
A H c D E A & < 0
1 93 1 12
Multiplies the number in Al by 15% Finds the square of the number in Al

To apply a formula to more than one cell, you can use the fill handle on the cell.

In this example, the AutoSum has been used to add the first column.

Click on the fill handle on Cell B6 and drag it to the right to create the same formula in C6,
D6 and E6.

B¢ Y e =SUUM{B28S) 56 - fo | =SUN4S2:88)

A 8 ¢ 2 £ A 3 ¢ ) g
i ncome  LiNities Food  Spending 1 income  Utilities food  Spenging
2 Weexl £120.00 £ 3265 £ 265 2 Weekl £120.00 £ 4265 £ 3265
3 Week2 E£12000 € 8225 £ S8 £13045 3 Week2 E120.00 £ 8225 £ 4820 £1304S
4 Weex3 £120.00 £ 3567 € & i Week3 E120.0 £ 3587 £ 3567
5 Weexs E12600 € 3672 £ €842 £i1nn 5 Weekd E12000 £ 5672 E 6542 £122.18
6 £530.00 6 £430.00

When you release the mouse, the results will be filled in.

g6 v B =SUM{E2:ES)
A 8 C 0 3

i income  Utiities Food Spending
2 Weekl £120.00 £ 4265 £ 8265
3 Week2 £12000 £ 8225 £ 4820 £130.45
4 Week3 £120.00 £ 3567 £ 35.67
5 Weekd £I12000 £ 5672 E 65.42 £12214
é £480.00 £133.97 £191.94 ] £339.91|

To check or edit a formula

If you want to check what the formula is, click in the cell you want to check. The formula or
calculation will appear in the formula bar. If you want to edit it, you can do this by typing
your adjustment in the formula bar. If you make a mistake, click on the X on the formula bar
or ESC on the keyboard. The formula will remain as it was. If you have already pressed
Enter to change the formulas, click on the Undo function on the Quick Access Toolbar.

You can also edit the formula within the cell. Double-click in the cell. It will display a
border around any cell references that are included in the formula. You can make your
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changes by typing the new formula in the cell or by dragging the handles on the borders
around the cells to reflect the change you want to make. When you press enter, the change
will be reflected in the formula and in the result. Click undo to reverse it if you realise it is
wrong.

1z Clicking and dragging the borders can be tricky.  You may get an error message to
alert you that the formula is no longer correct. Click on OK, and then go back to the cell to
correct the error and click undo, or re-enter the formula that you want.

Viewing Your Worksheets

When working with a worksheet, you often have to scroll down to see more of your data. It
is convenient to be able to see any headers you have at the top of the worksheet even when
you scroll down. Also, the first column may contain information that you want to keep when
you scroll to the right. Here is how to Freeze these rows and columns to keep then always
visible.

To Freeze Rows
1. Select the row below the row or rows you want to freeze. In this example, the top row
is to be frozen.
A2 - & 2018
A ) C o € & G
1 neome Sroperty Tax Gas Eiectne  \Water
2 | 2018 januaty £ 65000 £ 1500 € 3500 € 2000 £ &
3 Sebruacy £ 650850 £ 1500 £ 3500 £ 300 £ &
< March £ 65000 -£ 1500 £ 3500 E30900 £ &
? Aoril £ 65000 £ 1S60 £ 5500 € 00 £ 6
d May £ %X £ 1560 £ 3500 £ 0.0 £ &
7 June £ 83000 £ 1500 £ 3500 £ 3000 £ 6
2. On the View tab, select the Freeze Panes command, then choose Freeze Panes from
the drop-down menu.
t.‘ LA Pt

-

3. When you click back into the worksheet, a grey line will appear below the row(s)
which are frozen. When you scroll down, they will remain in view.

A 3 C [« E G K~

: _ Imcome Srcou‘yh\ Gas _Electric \Vater Food

Ny € 69000 £ 1500 € 3500 £ 3000 £ 60% £ 18
3 August £ 5 £ 1500 € 3500 £ 300 £ 600 £ 137
0 Septamber £ 63000 € 1S.00 £ 33500 £ 3000 € 600 & 16f
1 Oconer € 63000 £ 1500 € 380G £ 300C. £ 600 £ 2
12 Novgmber £ 63800 £ 1500 € 3800 £ We0 £ 600 € 16t
.3 Pormmbas & ASAMN ¢ CEAA £ SRAN I WNAA. £ kMM 2 N0
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To Freeze Columns

1. Select the column to the right of the column or columns you want to freeze. In this
example, the first two columns are to be frozen.

O X 5 Boa) - Lo Dol son-wneas o

1 o
m mive v o a3 1 Sty fan
o - - 3 0 |
2 4 = Sewge -
L ) T b -~ )
Lol - YT S VP
(49 . L roome
~ [] o 4
. : ] QAR g
P 38 arowy 14 SLY-- 5L N-- I
3 Pty L BN £HN ¢
- Marth [ 4 B e 7
3 o t "L 8% ¢
< ay 14 b4 & S 4% X BN
vy e L) R SaX et
2. On the View tab, select the Freeze Panes command, then choose Freeze Panes from
the drop-down menu, as above

When you click back into the worksheet, a grey line will appear to the right of the
columns which are frozen. When you scroll across, they will remain in view.

i ) G =
1 water  Food Ciothes
2 2013 January £ 600 £ 158500 E£17300
3 february (£ 600 £ 21112 £ 1500
M March £ 600 £ 18808 £ 4800
5 April £ 600 £ 18536 £ 3400
6 May £ S0C £ 1680C £ 3400

To Freeze Rows and Columns
1. Select the cell below the row(s) and to the right of the column(s) you want to freeze.

In this example, the first two columns are to be frozen.
A ) c ) 3

2 inoome Sropernty Tax Gas

2 wssacey [€ Soco]e 10 € 380

3 February £ 63500 £ is0C £ 3500

- Narch € 8000 € iS00 £ 3500

5 Asrl € 85000 ¢ 1500 £ 3500
2. Onthe View tab, select the Freeze Panes command, then choose Freeze Panes
from the drop-down menu.

. When you click back into the worksheet, a grey line will appear below the frozen rows
and to the right of the columns which are frozen. When you scroll across, all will
remain in view.

A L 4 -

. me Rl Cotes

Getoser € 800 € 12 4 BX
s veversder £ S0 £ WO £ KX
i Deterier £ 400 € USM £ M2
- 214 vy € 630 € 00 £ Ko
| Fabrupy £ 680 £ 202 £ M
o~ Naver £ 620 € 4808 ¢ R
o L f 4 ¢ WM (KXY
b+ My £ 400 € a0 € ux
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To Unfreeze Rows and Columns

To unfreeze rows or columns, click the Freeze Panes command, then select Unfreeze Panes

from the drop-down menu.

“lint: If you only want to freeze the first row or the first column, select the Freeze Panes

command on the View tab, and click on Freeze Top Row or Freeze First Column.

Changing the view of Data

Sorting Data

If you want to view your data in a different way, there are ways to do it. For example, if you
have your address list in a worksheet, you may want to sort it by the surnames of the people

on the list.
A ’ ¢ D E F e - | r ¥
I e Fire N 5 i Locrend  btcrem) Lrrens Camoury! Comptry? Comiory’s Camporpt
< n e Saen 1500dsoes Cotban  SoowyKT2TW  Bepiont Covore ¥ide;  Eanw
1A Al o Ooe T3endslave Cothas  Suew WTITW e ) Lovw
Ay At Do Sy ISerdylans Ode ooy KITW Dcsarer Mok,
LB A8 = R 48 Lave Cothens Soom WY T Dvwrm Yomv
A AV Ao Sucenome  S8a0d,Lire Clthem  Buve,XT2TW v
TN AU ey Rasss (et lee CRNe  Sow KTITA Crratmas Hobde
W Atn W D Yadsiee Cottes SpeMTITN Cram
P B e 930 lae Cobees  Sovey K137 Dreairay Hokdey
"nw N et ¥ Soad bave “oomwe Owtars UV ITS Conda Dwavmar Wbse
1w Rreoet Cinly W Sevsy Lae Cothe~ Sovey K12 T Crewras Maldey Esee
1A AUn Rt Svn MR Lavw Coman  Sesey KTRTW e
. 1 B - C Q
Click a cell in the column you want to sort ORI O, B2 L PO
by. 2 e Jane 1 Sandy Lane
3 W BUrg Jotn Sandy Line
4 W Ll Dedd 3 Sandy Lane
? Wil I Witn 4 Saney Lave
§ A ilUn Xt Duskwom 5 Sendy Lane
i O¥s  Pitw e
Click on the Data tab and select to sort } ,
2 2} Connections iy
il L4 TS
AtoZor to sort Zto A. In the example, Z] st P
A-Z is selected.
. . . A 5 C
The w:irksheet will immediately be sortedas |, _ ¢ _ & -
selected. 2 Me&Mrs Waves  Bsch
7 K &M George Bengon
o K & Mrs Alastar Caok
§ Nr 8/ Do Csan
G e &M Jobn Dco
T e &M Jon Ducinrtnth
§ Ke g Jown Eas
S Kv 3N Cesd Gacrpe
10 R Merk Hend
17 Ny Jane Jones
12 We & Wus  lsa Tianin
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Filtering Data
You may only want to see part of the data in your worksheet, or you may be looking for a
particular item. You can use ﬁltermg to do this.

8 [ F o " i ¢

% m- Flest Neme Sumarre m- w m-: Adreest Comgony! Comgony2 Catagonys |
2 Un Jare Jovn 5ok Lane  Tobhan S K170 Bagland Owisimss Haltey  Eamiw
RIR R L Oow 28t Low THden Sy XTI TW Omatman Enatet
< W R QuN Owar IS Lave Ches Sy KT 70 Dwvoman e,
f Wates Yoz LS lete Soteen Sow ¥ TITW feT N ] Covw
iWim Jon Dath £S5 Lare Comam  Soep W0 T Cwern

W L1 Asvey Poptock G5y lme Cobmem  Scewy KT TR Crmimag Hdly)
T W AN Waee Sain TSmaylee Comen  Sueey K2 7Q = )
T e e et S5t Lee Cotea~ Sy K11 TM Cwaimay Moo
3 W N et $5end;Lone Tomts  Octaso AV IV Conade Chmatmay  Hstapy
1% M Relet “eda WSy Lee Cothan  Jymey XT3 70 Crasioas Malaw,  Datw
12 Mr A0 Rabee S 115endy Lowm Cobbam  Semey K2 T e 1)
18 S0 Almter  Cook 128000y Lww Cothan  Somey K57 TH Cwntrm
W By Geoge B 158mey Lo Covham Sy KD TN Cnsteoy Eanw
B Sl Nakoe  Vewtn HSendy Lase Cobhas  Suwey KD 70 Crpatmas  Wabdey
' N Rl Padddngar 3 Sendy Lo Cotbps Sy KT2 7V = S T
T ) e 1 Gecdy Lons  Oothan Somey KT2 TN Creigbmas Folcyy Eapter
Uk Shs Jote \Wings ey Lem Cotmen SomeyX12T0 e Eatty
¢ 0 Ood Tnirge 13000, Lav  Back ook Cowty Ovtie nieed Cvmmer Mty
Wb im um L5ees Lese Coem  SenwyKTI TN O«mu- Castw
2 M 3Wm ke Caame 353 ey Cohas  SoveyKT27H)

In this sheet, to see only the people to whom postcards are sent when on holiday, select any
cell in the worksheet. Select the Data tab, and then click on the Filter icon.

LA
L] Somt  Fier
| Z

A

Tabs w:ll appear at the top of each column. Click on the tab to see the choices of possnble
filters. Choose the filteror filters that you want to apply by leaving in the tick in the box in

: e/ FOIR : of the choice. Click OK and only
a0 : i E entries meeting that criteria will be
§;l'-' :"“"‘ 2 foa e, Cam E smwn.
§: - vt " -
§ B f T Pt
"v
u; il f t
5 ¥ g N v LR L=
2 € Ay : dey
3. ¥ R L] . Hawyl :

‘3 L]] .
% s :
cH 2
3 ¢
e Cavem
o | Corvoet
- 5 : 0 (= F G o) !
1 Tide « Flst Nen » Surname - Address! - Address: - Addross © Adressé * Categor ~ 3
Keo Jars Senith 1Sendy Lane Cobhem  Sumey KT27W!  England Christmas
{ N &Nre Daid Cean 3Sardy Laoe  Cobham  Sumey KT2TW Christmas - Holiday
/ W & Mrs  Ashiey Peacock 6 Sendy Lane Cothem  Surey KT27W Chnstmas  MHouday
4 hiss Ellen YWest 8Sondy Lane Cotham  Suerey KT2 W Cheistrras  Moliday
10 Me Mack Hand 9 Sardy Lane  Toronto Ontacie M3V 275 Canada Christmas  Holday
11 Me Robent Wells 10 Sandy Lane Cotham  Sumey KT2 7W Chostemas  Moliday
5 Mr & Mes. Malcoim  Rason 14 Sandy Lane Cobham  Surrey KT2 7N Christeips  Holicay
17 Mry Jane Jores 1 Sandy Lane  Cothsem  Sumey KT2 Tl Christrras  Holoay
13 Me & s Daad Gearge 3 Sandy Lane  Blsck Rock County Dubla  Iretand Christmas  Holiday

~

Click on the Filter icon again to remove the filter and restore all the data.
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